# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>2</td>
</tr>
<tr>
<td>Features</td>
<td>3</td>
</tr>
<tr>
<td>System Requirements</td>
<td>4</td>
</tr>
<tr>
<td>Package Contents</td>
<td>5</td>
</tr>
<tr>
<td>Device Overview</td>
<td></td>
</tr>
<tr>
<td>Wireless USB Host Adapter</td>
<td>6</td>
</tr>
<tr>
<td>Software/Device Installation</td>
<td>7</td>
</tr>
<tr>
<td>Using the Wireless USB Manager</td>
<td>13</td>
</tr>
<tr>
<td>Technical Specifications</td>
<td>17</td>
</tr>
<tr>
<td>Cables To Go One Year Warranty</td>
<td>18</td>
</tr>
<tr>
<td>Important Safety Information</td>
<td>19</td>
</tr>
<tr>
<td>Appendix</td>
<td></td>
</tr>
<tr>
<td>Association with other devices</td>
<td>20</td>
</tr>
<tr>
<td>Cable Association Procedure</td>
<td>21</td>
</tr>
<tr>
<td>Pin Association Procedure</td>
<td>23</td>
</tr>
</tbody>
</table>
Thank you for purchasing the TruLink™ Wireless USB Host Adapter. This product utilizes the latest in wireless technology, so you can connect USB enabled devices such as printers, external hard drives, and digital cameras, monitors/displays up to 30 feet away. This adapter will transmit information from your PC to any Certified Wireless USB™ devices. With a highly secure connection you can use this product in settings such as corporate offices, classrooms, or in your home office/entertainment system. **NOTE:** In order for this adapter to operate, you must have a Certified Wireless USB Device in which it can communicate with. **We recommend that you read this manual thoroughly and retain for future reference.**
FEATURES

- Certified by the USB-IF, guaranteeing connectivity with all Certified Wireless USB™ products
- Based on Ultra Wide Band technology, providing speedy data transfer and low power consumption
- Convenient plug-and-play connectivity, with simple software installation and setup
SYSTEM REQUIREMENTS

- Microsoft® Windows® XP 32-bit with Service Pack 3 or higher
- or Microsoft® Vista® 32-bit/64-bit
PACKAGE CONTENTS

- Wireless USB Host Adapter for your computer
- One (1) Dipole Antenna
- USB Extender with Cradle
- Quick Start Guide
- Driver CD w/electronic User Guide
- Pin-Association stickers
**DEVICE OVERVIEW**

**WIRELESS USB HOST ADAPTER**

1. **Link: Data Connection Indicator**
   - LED is solid when transfer device is connected
   - LED blinks when data is being transferred

2. **PWR: Power**
   - LED is solid when powered by the PC
SOFTWARE/DEVICE INSTALLATION

IMPORTANT NOTE:

- If you have purchased this TruLink Wireless USB Host Adapter as an additional adapter to other TruLink Wireless USB Host Adapter/s and you have already installed the software on your PC, step 1 (software installation) can be skipped.

- If installing on Windows XP, Service Pack 3 (SP3) is required. Verify that this has been installed before installing the Wireless USB software.

- If installing the software, make sure that the Wireless USB Host Adapter and Wireless USB devices are not connected to the computer, and the Wireless USB devices are not powered.

Step 1-Installing the software
Insert the CD provided and the screen below will appear
SOFTWARE/DEVICE INSTALLATION

This will take you to the TruLink Wireless USB Kit InstallShield Wizard.

Click “Next” to go to proceed with the install.

Read and accept the Wireless USB Kit software License Agreement by clicking “Yes”.
SOFTWARE/DEVICE INSTALLATION

After the software installs your installation is complete and you can click the “Finish” button to exit the wizard. **Important: reboot/restart if prompted.**

---

Step 2-Driver Installation for the Wireless USB Host Adapter (for first time installation)

1. Open the Wireless USB Manager by double-clicking the icon on the icon tray at the bottom of your desktop.

    ![Figure: TruLink Wireless USB Manager](image)
SOFTWARE/DEVICE INSTALLATION

The Wireless USB Manager will open and instruct you on what to do next.

2. Make sure the antenna is connected to the Wireless USB Host Adapter.

3. Plug the Wireless USB Host Adapter into any available USB port on your computer. You also have the option to connect the Wireless USB Host Adapter to the USB Cradle provided in the package if you need to make the Adapter more mobile.
SOFTWARE/DEVICE INSTALLATION

Windows will automatically install the appropriate Wireless USB Host Adapter drivers and you will get a Successful Install message pop-up such as the following or one similar depending on your operating system to let you know it was successful.

![Successful Install Message](image)

**Figure: Successful Install Message**

In order to use Certified Wireless USB Devices with your Wireless USB Host Adapter, you need to associate your Certified Wireless USB Devices with your Wireless USB Host Adapter. Two methods can be used: Pin Association and Cable Association.

**PIN Association**
If your device supports PIN association (please refer to your Certified Wireless USB Device manufacturer’s user guide), click the Discovery Mode button and the Wireless Host Adapter will begin the discovery for your Certified Wireless USB Device. The discovery can take up to 30 seconds. After your Certified Wireless USB Device is found you will be asked to enter the Certified Wireless USB Device pin number. Enter the PIN and then press OK. Your Certified Wireless USB Device is now associated and ready to be used with your Wireless USB Host Adapter.

![Discovery Mode Screen](image)

**Figure: Discovery Mode Screen**
**SOFTWARE/DEVICE INSTALLATION**

**Cable Association**
If your Certified Wireless USB Device does not support PIN association you will have to perform a cable association. Please refer to your Certified Wireless USB Device manufacturer’s user guide for instructions on how to do a cable association for your Certified Wireless USB Device.

After your Certified Wireless USB Device is successfully installed, your device icon will appear on the Display: All Devices page in the Wireless USB Manager.

On the Devices screen of the Wireless USB Manager, the icon for your Certified Wireless USB Device will be in color (example: **TruLink Hub**), indicating your Certified Wireless USB Device is active and ready to use.

![Figure: Wireless USB Hub Connected](image)

When your TruLink USB Host Adapter is not in use, you may disconnect it from your PC if you wish, and connect it back whenever you are ready to use again. Simply plugging the Wireless USB Host Adapter back in your PC will begin automatic reconnection as long as your Certified Wireless USB Device is still powered on.
USING THE WIRELESS USB MANAGER

WIRELESS USB MANAGER

The Wireless USB Manager is simple and easy to use interface to manage your Wireless USB devices and control your Wireless USB Host Adapter settings. The Wireless USB Manager can be accessed via Wireless USB Manager Icon in the Windows tray (Figure: Wireless USB Manager Icon).

To launch the Wireless USB Manager, double click on the Wireless USB Manager icon. In the main pane, you can find an icon representing your Certified Wireless USB Device. If your Certified Wireless USB Device is not connected, the icon will be grayed out (Figure: Wireless USB Hub Not Connected). If your Certified Wireless USB Device is connected and ready to work, the icon will change and show signal strength (Figure: Wireless USB Hub Connected).
**USING THE WIRELESS USB MANAGER**

The **View** menu will give the option of what type of devices you wish to display (All Devices, Connected Devices and Not Connected Devices).

The **Options** menu will give the option to launch Host Settings window and turn the Wireless USB Host Adapter radio on or off.

The **Help** menu offers quick help on how to connect devices to your Wireless USB Host Adapter.

Figure: Wireless USB Hub Connected
**Using the Wireless USB Manager**

To manage the Wireless USB Host Adapter settings, either select “Host Settings” in the “Option” menu of the Wireless USB Manager application or right click on the Wireless USB Manager icon in the Windows tray.

**General Tab** (Figure: Host Settings – General)

1. Enable this Wireless USB radio: turn on or off the Wireless USB radio.
2. Host name: Change the name of your Wireless USB Host Adapter.
3. Cable association connection rules: Always, Never or Ask me each time. By default Wireless USB will ask you each time you cable associate.
USING THE WIRELESS USB MANAGER

**ADVANCED TAB** (Figure: Host Settings – Advanced)

1. Channel selection: this function allows you to set manually a radio channel for the wireless communication (combination of Band Group and Channel). For optimal performance, the automatic setting is recommended.

![Figure: Host Settings - Advanced]
<table>
<thead>
<tr>
<th>TECHNICAL SPECIFICATIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating System Support</strong></td>
</tr>
<tr>
<td><strong>PHY Data Rate</strong></td>
</tr>
<tr>
<td><strong>Operating Range</strong></td>
</tr>
<tr>
<td><strong>Frequency</strong></td>
</tr>
<tr>
<td><strong>Number of Channel</strong></td>
</tr>
<tr>
<td><strong>RF Modulation Type</strong></td>
</tr>
<tr>
<td><strong>Interface</strong></td>
</tr>
<tr>
<td><strong>USB Specification</strong></td>
</tr>
<tr>
<td><strong>Association Mode</strong></td>
</tr>
<tr>
<td><strong>Antenna Type</strong></td>
</tr>
<tr>
<td><strong>Max Output Power</strong></td>
</tr>
</tbody>
</table>
At Cables To Go, we want you to be totally confident in your purchase. That is why we offer a one year warranty on this device. If you experience problems due to workmanship or material defect for the duration of this warranty, we will repair or replace this device. To request a Return Merchandise Authorization (RMA) number, contact customer service at 1-800-293-4970 or www.cablestogo.com.
IMPORTANT SAFETY INFORMATION

! Do not plug the unit in any outlet that does not have enough current to allow the device to function. Refer to the specifications in this manual for power level of the unit.

! Liquid:
If this unit or its corresponding power adapter has had liquid spilled on or in it, do not attempt to use the unit. Do not attempt to use this product in an outdoor environment as elements such as rain, snow, hail, etc. can damage the product.

! In case of a storm, it is recommended that you unplug this device from the outlet.

! Avoid placing this product next to objects that produce heat such as portable heaters, space heaters, or heating ducts.

! THERE ARE NO USER SERVICEABLE PARTS
Do not attempt to open this product and expose the internal circuitry. If you feel that the product is defective, unplug the unit and refer to the warranty information section of this manual.

©2009.Cables To Go is a trademark of Cables To Go. Microsoft and XP/Vista are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. This product is not endorsed or manufactured by Microsoft Corporation.
ASSOCIATION WITH OTHER DEVICES

ASSOCIATION CONCEPT

In order to establish a secure wireless connection, both the Wireless USB Host Adapter and your Certified Wireless USB Device must exchange information about each other. This is done via cable or PIN association.

ASSOCIATION PROCESS

If you purchase additional Certified Wireless USB devices, you will have to associate them with your Wireless USB Host Adapter. Refer to your Certified Wireless USB Device documentation for more information on its settings for association or try contacting the product’s manufacturer for assistance if needed.
**APPENDIX**

**CABLE ASSOCIATION PROCEDURE**

Cable association steps: Examples/Figures shown used with the association of the TruLink Wireless VGA Device Adapter

1. Make sure that the Wireless USB Manager is running. Check your Windows tray for the Wireless USB Manager icon (Figure: Wireless USB Manager).
2. Make sure the WIRELESS/WIRED switch is in the WIRELESS position
3. Plug in the power supply for your Wireless USB device adapter (TruLink Wireless VGA Device Adapter).
4. Connect the USB cable between an available USB port on your computer and your Wireless USB device adapter.
5. Complete cable association by pressing the “Accept Association” button when prompted. (Figure: Cable Association)
6. Remove the USB cable from your Wireless USB device adapter and computer.

![Figure: Cable Association](image-url)
Associated Certified Wireless USB Devices will appear as icons in the Wireless USB Manager. When the Certified Wireless USB Devices are connected, the icons will appear in color (Figure: Wireless VGA Adapter and TruLink Hub Connected).

Note: You may rename or delete the Wireless USB Device Adapter by right-clicking the device icon in the Wireless USB Manager and select “rename” or “delete”.

Figure: Wireless VGA Adapter and TruLink Hub Connected
PIN ASSOCIATION PROCEDURE

PIN association steps: Examples/Figures shown used with the association of the TruLink Wireless VGA Device Adapter.

1. Make sure your Certified Wireless USB Device is powered on and your Wireless USB Host Adapter is connected to your computer. Click the “Discovery Mode” button (Figure: Discovery Mode Screen).

Figure: Discovery Mode Screen
APPENDIX

2. The Wireless USB Host will search for any available Certified Wireless USB Device within its range. Note that this operation can take up to 20 seconds (Figure: Discovery Mode in Process).

3. Once the Wireless USB Host Adapter and the Certified Wireless USB device have exchanged security information, the following dialog will appear.
APPENDIX

4. Enter the PIN of the Wireless USB device (4-digit PIN) and click Accept Association. The Wireless USB device and Wireless USB Host Adapter are now associated and ready for operation. Stickers have been provided in case you would like to write down the 4-digit PIN of your Certified Wireless USB Devices. Sticker can be applied to your Certified Wireless USB Devices.
For more information on this product or to check for updated drivers, manuals or frequently asked questions please visit our website.

www.cablestogo.com